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Introduction 
 
Congratulations on your purchase of SentryPlus to monitor and manage your Uninterruptible 
Power Supply (UPS).  SentryPlus is designed to provide end users the ability to take proactive 
steps to protect their equipment from power related damages.  SentryPlus allows for automatic 
shutdowns, scheduled shutdowns and a variety of other features that will help you manage your 
system and its peripheral components. 
 
SentryPlus provides detailed information about the UPS and its protected equipment.  It is easy 
to install and program, yet has the necessary features to manage all of your power requirements. 
Included is the capability for network management protocol (SNMP and DMI).  SentryPlus will 
disseminate UPS information into SNMP protocol and send it to the appropriate Network 
Management Station (NMS), such as HP OpenView.  To make use of the resources on the 
Internet, SentryPlus also supports HTTP protocol.  This enables end-users to monitor their 
UPS anywhere, anytime, by simply utilizing their web browser. 
 
SentryPlus runs in the background as a Windows service, and communicates with the UPS in 
order to ensure that your computer and attached equipment are protected from any power 
problems. 
 
SentryPlus features: 
1. Graceful operating system shutdown. 
2. Scheduled tests, shutdown/restarts of the UPS, turn on/off receptacles. 
3. Flexible events. 
4. Notification: SMS, Pager, e-mail, network broadcasting, SNMP and audible alarm. 
5. Real-time values of voltage, current, frequency and loading. 
6. Historical data & graph. 
7. Network monitoring. 
8. Multi-computer shutdown/restart. 
9. Support Simple Network Management Protocol (SNMP). 
10. Support Desktop Management Interface (DMI). 
11. Support HTTP, remote monitor and control using Internet browser. 
12. Support Universal Serial Bus (USB). 
13. Multi-lingual menus. 
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SentryPlus Installation 
 
SentryPlus Setup: 
1. Place the SentryPlus CD in your CD-ROM drive.  The Install Shield will automatically start 

and guide you through the setup procedure. 
2. Check the communication type of your UPS.  If you select the USB option you must have 

connected the UPS to this computer.  The OS will find the new hardware.  Simply follow 
the prompts to install the HID driver. 

3. During the installation, the following dialog gives you 5 options: 
z Program File: Files contain SentryPlus Service, SentryPlus Monitor and this on-line 

help. 
z Audio Files: Some .wav files. These files will be played to notify you when power event 

occurs. 
z SNMP Files: SentryPlus SNMP DLL file. 

4. After finishing the installation, the setup program will create a SentryPlus association. 
The SentryPlus software is comprised of two modules: 
z A UPS Monitoring Module (SentryPlus Status), which runs in the background as a 

Windows NT Service and communicates to the UPS. 
z A User Interface Module (SentryPlus Monitor), which enables you to control and 

configure SentryPlus through the drop down menus and dialog boxes.  It also allows 
you to monitor the UPS through the Main Screen. 

 
Help: SentryPlus on-line help. 
Setup: To modify, repair or remove SentryPlus from your hard disk. 
SentryPlus Monitor: User interface, used to monitor and configure UPS. 
SentryPlus Status: SentryPlus Status program, used to communicate with your UPS. 
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SentryPlus Service 
 
SentryPlus Service runs in the background as a Windows NT Service when the system initiates.  
You can also run SentryPlus Service manually by selecting the Start Menu- Program Files - 
SentryPlus - SentryPlus Status.  Once SentryPlus Service starts there is a SentryPlus Status 
icon located on the system tray to indicate UPS status. 
 
 
 

 
 
SentryPlus icon 
 
 
1. Normal.  The UPS is operating on utility power. 
 
 
 
 
 
2. UPS Disconnect.  The SentryPlus Monitor cannot get any information from the UPS. 
 
 
 
 
 
3. Program Stopped.  The SentryPlus Monitor has been stopped. 
 
 
 
 
 
4. Power Failed.  The UPS is operating on battery power. 
 
 
 
 
 
5. UPS Bypass Active.  The UPS is operating on Bypass power. 
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Right clicking on the SentryPlus icon in the system tray will display the following menu: 
 
 
 
 
 
 
 
z Show Countdown: SentryPlus displays the countdown time (time to shutdown/suspend the 

operating system) window to remind the user that the operating system will be shutdown or 
suspend in the displayed time.  This function lets the user know how much time is left to 
shutdown/suspend the computer when power fails.  The operating system shutdown time 
can be adjusted from the Action menu. 

 
 
 
 
 
 
z Monitor: Run the SentryPlus user interface. 
z Configuration: Displays the configuration window, and allows you to change the UPS 

parameters. 
z Meters: Shows UPS real-time meters. 
z Program Stop: If this item is marked then SentryPlus will stop.  Unmark it and the program 

will resume. 
 
Once a power event has occurred, SentryPlus will pop up a broadcast dialog box to inform user 
what happened to UPS.  The Messenger service must be running to receive broadcast 
messages. 
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SentryPlus Monitor 
 
SentryPlus Monitor enables you to control and configure SentryPlus through the drop down 
menus and dialog boxes.  It also allows you to monitor the UPS through the Main Screen.  It is 
not necessary for SentryPlus Monitor to reside in your computer’s memory this execution 
depends on the user's requirement and can save precious system resources. 
 
After finishing the SentryPlus installation, SentryPlus Service automatically loads into memory 
and runs once the Windows operating system starts up.  There will be a SentryPlus icon in the 
system tray to indicate the current UPS status. 
 
 
 
 
SentryPlus icon 
 
To run the SentryPlus Monitor, double click on the SentryPlus icon in the system tray, or right 
click on the SentryPlus icon to open the menu: 
 
 
 
 
 
 
 
 
 
Then select Monitor to run the program.  You can also launch SentryPlus Monitor without 
running SentryPlus Service, select SentryPlus Monitor from Program Files - SentryPlus menu. 
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SentryPlus Monitor Main Screen: 
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Networking 
 
SentryPlus is comprised of two modules:  SentryPlus Service and SentryPlus Monitor.  You 
may run both the programs in a computer to monitor your localized UPS or run the programs in 
two different computers. 
 
Operation Modes 

 
 
 
 
 
 
 
 
 
SentryPlus Service can operate in "Master" Mode (which allows SentryPlus to send 
commands to its connected UPS) in "Serial Slave" mode (which listens to its connected 
UPS) or in "Networking Slave" mode (which obtains the UPS information from Master via 
the network).  If two or more computers are communicating with a single UPS, only one of 
these computers should be in Master mode; the others should be in Slave mode to prevent 
them from sending contradictory commands. 
 
 
 
 
 
 
 
When a power event occurs, the Master gets the information then transmits it to the 
Slave(s).  Each SentryPlus Service executes different "Actions"(FlexEvent) so that the 
system manager can configure different strategies into each different computer.  For 
example: When a power failure occurs, the file server and mail server will not shutdown 
until the UPS battery is low, but other less important workstations execute shutdown after 
5 minutes, and the initial workstations shutdown after 10 minutes.  Shutting down 
workstations preserves more battery power for your mission critical network servers. 
 



 10

Remote Monitoring and Control: SentryPlus Monitor 
SentryPlus Monitor has the ability to monitor Local host and Remote host. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
You can run SentryPlus Monitor only without running SentryPlus Service.  SentryPlus 
Monitor will search hosts in the LAN (Local Area Network), which runs SentryPlus Service 
in the combo box.  Click on the Host Selection combo box to list the searched hosts in the 
LAN.  Select one, then SentryPlus Monitor will connect to the selected host. 
 
 
 
 
 
 
 
 
 
 
 
 
If the host is located on the Internet, you can also input the remote host IP address from 
the View Menu- Remote Hosts menu shows the hosts you can establish connections with. 
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Remote Monitor and Control: Internet Browser 
Another way to remote monitor SentryPlus Service is by using the Internet Browser. 
Launch the Microsoft Internet Explorer or Netscape Communicator, type the IP address in 
the URL and press enter you will then be able to see the UPS information.  You can 
change the network port number to prevent conflict with other WEB server programs.  If 
the port number is not 80 you have to type the URL like this: http://172.16.176.141:2000 
where 2000 is the port number you assigned. 

 
Enter the User Name and Password.  The default User Name and Password is admin. 
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SentryPlus Monitor Operation 
 
The Main Screen has 7 areas that present information on the operating status of your UPS. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Host Selection: Press the combo box to select hosts that runs SentryPlus in the LAN. 
Users can monitor or control the UPS remotely (password is needed). 
Connection Indication: The logo will rotate while the communication between SentryPlus 
Monitor and SentryPlus Service is established. 
Information Display: Press Bottom Layer Buttons to change the information that is 
displayed in this area. 
Recent Event Log: Preserve last 10 event logs in the combo box, click on the combo box 
to pull down and view the logs. 

 
Top Layer Buttons 

These buttons are used to display information about your UPS, refer to the dialog boxes in 
the menu. 
Configuration: Same as the System-> Configuration in the menu. 
Meters: Same as the View-> Meters in the menu. 
Event Log: Same as the View-> Event Log in the menu.  
History Graph: Same as the View-> History Graph in the menu. 
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SentryPlus Monitor Main Menu 
The Main Screen has a menu bar at the top with 5 main options: 
System: This menu allows you to set the SentryPlus and computer parameters. 
Control: This menu allows you to set UPS buzzer, outlet, and test. 
View: The View menu allows you to see the real-time values and history event or history 
data. 
Wizard: Directs users to configure the most frequently used settings, the wizard guides 
users step-by-step to finish their configuration. 
Help: The Help menu allows you to access the online help system. 
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System 
 
The system menu allows you to configure the UPS and monitoring screen parameters.  When 
you select the System menu from Main Menu bar, a drop down menu appears offering you the 
following menu options: 
Login: Used for Remote Monitor. User must enter a password before he can control or 
configure the UPS. 
Configuration: The Configuration menu allows you to tailor various SentryPlus parameters. 
Monitor Screen: Allows you to change display item in the Scroll screen of Information Display 
Area. 
Font: Sets the font size. SentryPlus will resize the window automatically. 
Window: This menu allows you to change the displayed items in the Information Display Area.  
The items in the menu refer to each button in the Bottom Layer Buttons. 
Close Monitor: Stops SentryPlus Monitor. 
 
 
 
 
 
 
 
 
Login 

When attempting to use SentryPlus Monitor as a Remote Monitor (connect to different host) 
you have to enter the password for verification if you want to do such tasks as 
configuration, or to control the UPS.  Otherwise, you can only view the UPS information.  
If user runs SentryPlus Service and SentryPlus Monitor on the same computer, you can 
perform such configurations or control the UPS without the password.  To change your 
password, please choose the Set Password from Configure - Network menu. 

 
 
 
 
 
 
 
 
 



 15

Monitor Screen 
This dialog box allows you to change display item in the Scroll screen of Information 
Display Area. 
Language: Choose a language that suits your operating system needs.  The software will 
automatically replace the on-line help file and audio files to your selected preferences. 
Meters: Press the Main button from the Bottom Layer Buttons, and you will see that there 
are two meters in the information area.  You can change the displayed items of the two 
meters.  
Scroll Window: Press the Scroll button from the Bottom Layer Buttons, and the scroll 
window will display the information in this area.  This item allows you to change the 
display menu and its items. 
 
 
 
 
 
 
 
 
 
 
 
 
 

Font 
This menu allows you to change the font size of SentryPlus Monitor window. 
 

Window 
This menu allows you to change the display items in the Information Display Area.  The 
items in the menu refer to each button in the Bottom Layer Buttons. 
 

Close Monitor 
Close SentryPlus Monitor and leave SentryPlus Service running. 
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Configuration 
 
The Configuration Screen has a menu bar at the top with three main options: 
Devices: This menu allows you to configure modem, pager and e-mail applications. 
UPS: The UPS menu allows you to plan and set the UPS schedule or perform the Action. 
Network: This menu allows you to choose the Master/Slave settings or configure SNMP, HTTP 
functions. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
Configuration Window 

UPS Communication Port: COM1, - COM4, USB. 
Next UPS Test Date/Time: The date of the next user-initiated UPS self test.  Setting from 
System->Configuration->UPS->Schedule. 
Next UPS Shutdown Date/Time: This field displays the date of the next shutdown the 
computer and UPS.  Setting from System->Configuration->UPS->Schedule. 
Next UPS Restart Date/Time: The date of the next restart UPS.  Setting from 
System->Configuration->UPS->Schedule. 
Local Host IP: IP address of a computer, which runs SentryPlus Monitor. 
SentryPlus Service Mode: SentryPlus Service acts as a Master or Slave. 
Remote Host IP: The host, which runs SentryPlus Service.  If SentryPlus Monitor and 
SentryPlus Service runs on the same computer and this field will be empty. 

 



 17

Devices 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
Notification Users -- Pager List 

To let SentryPlus notify you via pager you must setup the modem device.  If you select 
the TAPI (Windows Telephony Application Programming Interface) then Windows will 
handle the modem device, otherwise, SentryPlus will control the modem device directly 
(AT Command). 
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The software will set the modem to notify all via the pager numbers, which are listed in the 
pager list.  You can input your pager number for your own notification purposes.  For 
example: 060123456 is your pager number, each ',' tells modem to delay 2 seconds, delay 
time is for setting waiting period for the response signal, before proceeding to transmit to 
the displayed number 119.  119 will appear in your pager LCD. 
 
To trigger the pager notification you must enable the Pager Action in the Action dialog box. 
a. COM Port: The communication port COM1 - COM4. 
b. Baud Rate: Set the data transmitting speed. 
c. Initialize String: The string, which is sent to the modem before paging is attempted. 
d. Dial Prefix: The string, which is added to the beginning of each of the Pager Number 
before they are sent to the modem. 
e. Using TAPI: Lets Windows handle the modem device. 
f. Add: Add a new pager number. 
g. Modify: Modify the selected pager number. 
h. Delete: Delete the selected pager number. 
 

Notification Users - email 
You can also e-mail users through SMTP when power events occur. 
 
To trigger the e-mail notification you must enable the e-mail Action in the Action dialog box. 
a. Add: Add a new user. 
b. Modify: Modify the selected user name. 
c. Delete: Delete the selected user. 

 
Notification Users - Network Broadcast 

You can also broadcasting information to users when power event has occurred.  The 
broadcast function is associated with Microsoft Messenger to send messages you must run 
under the Windows NT operating system. 
 
To trigger the broadcasting notification you must enable the Broadcast Action in the Action 
dialog box. 
a. Domain: Enable this item to broadcast to all the users in the domain, otherwise 
SentryPlus will send messages to the hosts that users assigned. 
b. Add: Add a new machine name. 
c. Modify: Modify the selected machine name. 
d. Delete: Delete the selected name. 
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Notification Users – SMS (Short Message Service) 
To let SentryPlus notify you via SMS (Short Message Service) you must setup the GSM 
modem or connect the mobile phone to your PC (Nokia is recommended). 
 
To trigger the SMS notification you must enable the SMS action in the Action dialog box. 
a. COM Port: The communication port COM1, - COM8. 
b. Baud Rate: Define the data transmitting speed. 
c. Add: Add a new mobile phone number.  
d. Modify: Modify the selected number. 
e. Delete: Delete the selected number. 

 
Color 

Used to change the screen color. 
a. Color Items: This area lets you select an item, which you want to change the color for. 
The right-top corner color will display current selected color. 
b. Change: Change the color you have selected. 
c. Default: Default setting. 
d. Exit: Close the dialog box. 

 
Close 

Close the Configuration window. 
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UPS 
 
 
 
 
 
 
 
 
 
 
UPS Property 

This dialog box allows you to configure the UPS COM port, battery replacement date, etc.  
Load Warning and Load Severity used to prevent UPS overload (see the UPS hardware 
user manual).  In general, Load Warning will notify users to reduce the UPS load, Load 
Severity will shutdown the computer to prevent overload. 
a. COM Port: COM1 - COM4, USB. 
b. Load Warning: Load warning. 
c. Load Severity: User must reduce UPS load. 
d. Last Battery Replacement Date: Records last battery replacement date. 
e. Next Battery Replacement Date: Displays the date of the next battery replacement, 
SentryPlus will notify users to replace the battery. 
f. Host Name: Local host name. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 



 21

Attached Devices 
Allows the user to assign the attached device a name.  When you are controlling the 
receptacle, SentryPlus will let you know which devices you are controlling. 
a. Select an Outlet Group: Assigns an outlet group.  Please look at the back panel 
carefully, some outlets may share one control relay, these outlets are called outlet group.  
If you turn off outlet group (for example:  outlet1 and outlet2) then the UPS will stop power 
to the outlet group outlet1 and outlet2. 
b. Device Name: Assigns the attached devices a name, for example:  Outlet Group1 is 
called Monitor for association with the monitor and Outlet Group2 is called Computer for 
association with the CPU.  These records can improve the efficiency of your management.  
Do not forget to press the Update button. 
c. Update: Updates your change. 

 
 
 
 
 
 
 
 
 
Log Management:  

a. Maximun Event Log Entries: This is the maximum number of Events that SentryPlus will 
log. 
b. Data Log Interval: Time designated for automatic saving of a record of UPS data. 
c. Maximum Data Log Storage: It allows you to save how many months of UPS data files 
you wish to keep. 
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Schedule 
This function allows you to shutdown, restart, test and turn on/off the receptacles.  You 
can schedule up to 6 events.  Settings are based on day, week or month and up to a 
period of 2 years. 
 
Choose the appropriate applicable schedule: 
a. One Time: This set schedule is applicable for a single day. 
b. Daily: This set schedule is applicable for every day. 
c. Weekly: This set schedule is applicable for once a week period. 
d. Monthly: This set schedule is applicable for once a month period. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Action 
The action menu provides you with a list of events to choose from.  The event and/or any 
combination of these actions can be selected from the Choose Event list box.  Actions 
that are already enabled will show a check mark.  To delay the actions, set the desired 
time for delay in the Delay combo box. 
a. Choose Event: When you select one item in the list the action buttons will display current 
settings.  Press the button to do more configurations. 
b. Set Default: Set all the actions to default values. 
c. Delay: The power event must stay within the delay time to trigger actions. 



 23

 
 
 
 
 
 
 
 
 
 
 
 
 
 
Action – Shutdown 
Shutdown/Hibernate/Suspend the operating system or shutdown the UPS.  The action of 
“shutdown”, “hibernate” or “suspend” are the same as if you select the Shutdown option 
from the Windows Start menu. 
 
 
 
 
 
 
 
 
 
 
 
 
 
Action – Logging 
Allows you to log events as well as modify the default logging message.  You can see this 
message in the Event Log dialog box. 
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Action – Broadcasting 
Permits you to broadcast an event based on a set period of time.  If you want to be 
notified once, set the time period to "0".  However, if you want to be notified more than 
once, set the time period to a larger number.  Each number corresponds to the number of 
times of notification. 

 
 
 
 
 
 
 
 
 
 

Action - Command 
Permits you to execute command files and set a period of time to delay its activation.  To 
test this function, you can click the Test button.  To enable or disable this action, mark the 
Enable Command check box. 
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Action – Alarm 
Permits you to send out audible alarm instead of a broadcast message.  There are two 
alarms to select from - Buzzer and Audio.  If you choose Audio, the SentryPlus requires a 
".wav" file to emit the alarm.  You can browse your system for other ".wav" files by clicking 
on the Browse button.  If you want to be notified once, set the time period to "0".  
However, if you want to be notified more than once, set the time period to a larger number.  
Each number corresponds to the number of times of notification. 

 
 
 
 
 
 
 
 
 
 
 

Action - email 
Permits you to send e-mails through SMTP.  If you want to be notified once, set the time 
period to "0".  However if you want to be notified more than once, set the time period to a 
larger number.  Each number corresponds to the number of times of notification.  You 
can edit the user list by clicking the Edit list button, and add, modify or delete any user 
name in the list.  To enable or disable this action, mark the Enable e-mail check box. 
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Action – SMS (Short Message Service) 
Permits you to send SMS through GSM modem or mobile phone.  You can edit the user 
list by clicking the Edit list button, and add, modify or delete any user name in the list.  To 
enable or disable this action, mark the Enable SMS check box. 

 

 
 
 
 
 
 
 
 
 
 
 
 
 
 

Action – Paging 
Allows you to set the time period for paging intervals.  If you want to be notified once, set 
the time period to "0".  However, if you want to be notified more than once, set the time 
period to a larger number.  Each number corresponds to the number of times of 
notification.  
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Action - SNMP Trap 
Lets you send a SNMP trap when the related power event occurs.  To enable or disable 
this action, mark the Enable SNMP Trap check box.  You also need to specify the SNMP 
Trap target hosts and community string.  Please see the SNMP dialog box in the Network 
menu. 

 
 
 
 
 
 

Action - Receptacle Control (not all UPSs support this function) 
Allows you to control the Receptacle Relay on or off.  Each Receptacle Relay may control 
not only one outlet, please see the rear panel of your UPS or the UPS hardware user's 
manual. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
Stop All Action 

Clicking on this terminates all the actions immediately. 
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Voltage Sensitivity (not all UPSs support this function) 
Adjust the UPS voltage sensitivity. 

 
Transfer Voltage (not all UPSs support this function) 

Changes the low voltage and high voltage transfer points.  This function lets your UPS 
adjust to the local power environment. 
a. Low Voltage Transfer point: When the utility power voltage drops lower than the 
assigned value the UPS will switch to backup mode.  The output power is supplied from 
the battery. 
b. High Voltage Transfer point: When the utility power voltage rises higher than the 
assigned value, the UPS will switch to backup mode.  The output power is supplied from 
the battery. 
 

External Battery Pack (not all UPSs support this function) 
The RS232 port MUST be used when configuring the UPS for External Battery Packs.  
The USB port does NOT support configuring the UPS for External Battery Packs.  When 
using an External Battery Pack with the UPS, the UPS must be configured; to report the 
correct Estimated Runtime and so that the Battery Capacity Bar Graph LEDs on the front 
panel will work properly during the battery mode operation.  Simply click on Configure, 
UPS, and then External Battery Pack.  Then select the number of External Battery Packs 
that are connected to the UPS. 
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Advanced UPS Property 
 
If your UPS does not support this function the item will be grayed out and the user cannot select 
this item. 
 
 
 
 
 
 
 
 
 
 
 
 
Enable Wakeup Computer: If your computer architecture is compatible to ATX and the BIOS 
supports RS-232 (RI) Wakeup function.  You should enable this item to make the Schedule 
work correctly. 
Enable Resume Computer: Be sure the BIOS supports RS-232 (RI) Wakeup function.  When 
SentryPlus suspends the computer and the UPS detects the change of power status, the UPS 
will resume the computer to its prior operating status and let SentryPlus notify users. 
Enable Power Fail, Auto-Reboot: If you enable this function, the UPS will reboot to restart the 
computer otherwise, it will go back to its normal state. The time-line describes below: 
 
 
 
 
 
 
 
 
 
Enable Economic Mode (not all UPSs support this function): Switches to UPS economic mode. 
UPS Periodic Auto-Test: Daily, weekly, biweekly and monthly.  UPS starts the test procedure 
automatically when it reaches the preset time. 
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Network 
 
 
 
 
 
 
 
 
Set Password 

Sets the SentryPlus Service password. 
 
 
 
 
 
 
 
 
 
 
 

Choose Master/Slave 
Please refer to the SentryPlus Service operation mode.  If the computer connects to UPS 
directly (with RS-232 or USB) and can send commands to its connected UPS then the 
SentryPlus Service acts as a "Master".  If it connects to UPS directly (with RS-232 or USB) 
but only listens to UPS then it is a "Serial Slave".  If the computer is powered by the UPS, 
but obtains the UPS information from Master via TCP/IP network then it is a "Networking 
Slave".  When SentryPlus Service is a Networking Slave you must assign the Master IP 
address so that the Networking Slave can connect to the Master and obtain the UPS 
information. 
 
a. Master: Configures the SentryPlus Service to be a Master. 
b. Serial Slave: Configures the SentryPlus Service to be a Serial Slave. 
c. Networking Slave: Configures the SentryPlus Service to be a Networking Slave. 
d. Master IP Address: When SentryPlus Service is a Networking Slave you must assign 
the Master IP address so that the Slave can connect to the Master host and obtain the 
UPS information. 
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Wake On LAN 
To wake up the remote host, SentryPlus sends notification through the network.  You 
must provide the IP address and the network hardware address of the remote host.  In 
Windows98, you can execute the "ipconfig /All" command under the MS-DOS prompt to 
obtain the network cards physical address of the local host.  Or, input the "arp -a" 
command to see the remote host’s physical address.  Your network card must support the 
remote wakeup feature and this function should be enabled. 
 
a. SentryPlus Resume The Computer From Suspend Mode: SentryPlus will reinstate the 
computer into normal mode, and the program will awaken the remote hosts once the 
actions have been enabled. 
b. Each Time SentryPlus Startup: Program will wake up the remote hosts which are 
enabled when SentryPlus starts and is connected to the UPS. 
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SNMP 
If you are using a Windows 95/98/Me operating system, you can configure the SNMP 
parameters directly from the SentryPlus: 
 
Select the Accept SNMP packet from any hosts, SentryPlus will accept all the requested 
commands and set commands.  When you select the Accept SNMP packet from the 
following hosts, SentryPlus receives information only from the hosts that you assigned.  
Once a power event has occurred and the user enables the SNMP Trap in the Action 
dialog box, SentryPlus will send the SNMP trap to the hosts that are listed in the Trap 
Target list box.  To add, modify or delete the host, click on its respective command button. 
 
If you are using a Windows NT or Windows 2000 operating system, you must install the 
SNMP Service and configure the SNMP parameters from your operating system: 
 
SentryPlus will ignore the values that were set in the SNMP dialog box.  To change the 
parameters of SNMP function, you should install the SNMP Service in the Network option.  
Select the SNMP Service from the Network option in the Control Panel and click the 
Property button to do your changes. 
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SNMP Trap Number 
 

Variable Trap No. Description 

dupsCommunicationLost 1 SEVER:  Communication with the UPS failed 

dupsCommunicationEstablished 2 INFORMATION: Communication with the UPS reestablished 

dupsPowerFail 3 WARNING:  Power failed.  The UPS is operating on battery power 

dupsPowerRestored 4 INFORMATION:  Power restored.  The utility power restored 

dupsLowBattery 5 SEVER:  The UPS batteries are low and will soon be exhausted 

dupsReturnFromLowBattery 6 INFORMATION:  The UPS has returned from a low battery condition 

dupsLoadWarning 7 INFORMATION:  Loading percent of the UPS over the Load Warning value 

dupsNoLongerLoadWarning 8 INFORMATION:  Returned from Load Warning condition 

dupsLoadSeverity 9 Warning:  Loading percent of the UPS over the Load Severity value 

dupsNoLongerLoadSeverity 10 INFORMATION:  Returned from Load Severity condition 

dupsLoadOnBypass 11 WARNING:  The UPS loads on bypass 

dupsNoLongerLoadOnBypass 12 INFORMATION:  The UPS is not on bypass mode 

dupsUPSFault 13 SEVER:  A general fault caused in the UPS 

dupsBatteryGroundFault 14 SEVER:  The UPS battery ground fault 

dupsNoLongerBatteryFault 15 INFORMATION:  The UPS recovered from battery ground fault 

dupsTestInProgress 16 INFORMATION:  The UPS test in progress 

dupsBatteryTestFail 17 SEVER:  The UPS battery test failed 

dupsFuseFailure 18 SEVER:  The UPS fuse failed 

dupsFuseRecovered 19 INFORMATION:  The UPS fuse recovered 

dupsOutputOverload 20 SEVER:  The UPS overload 

dupsNoLongerOverload 21 INFORMATION:  Recovered from UPS overload 

dupsOutputOverCurrent 22 SEVER:  The UPS output over-current 

dupsNoLongerOutputOverCurrent 23 INFORMATION:  Recovered from UPS over-current 

dupsInverterAbnormal 24 SEVER:  The UPS inverter abnormal 

dupsInverterRecovered 25 SEVER:  Recovered from UPS inverter abnormal 

dupsRectifierAbnormal 26 SEVER:  The UPS rectifier abnormal 

dupsRectifierRecovered  27 INFORMATION:  The UPS recovered from rectifier abnormal 

dupsReserveAbnormal 28 SEVER:  The UPS reserve abnormal 

dupsReserveRecovered 29 INFORMATION:  The UPS reserve recovered 

dupsLoadOnReserve 30 INFORMATION:  The UPS load on reserve 

dupsNoLongerLoadOnReserve 31 INFORMATION:  The UPS no longer load on reserve 

dupsEnvOverTemperature 32 WARNING:  The environment over-temperature 

DupsNoLongerEnvOverTemperature 33 INFORMATION:  The environment recovered from over-temperature 

DupsEnvOverHumidity 34 WARNING:  The environment over-humidity 

DupsNoLongerEnvOverHumidity 35 INFORMATION:  The environment recovered from over-humidity 
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HTTP 
SentryPlus supports WEB Server for remote manager to obtain the UPS information.  
Users can use IE or Communicator to connect with SentryPlus Service.  Even if your 
computer does not have SentryPlus installed you can monitor and control your UPS via 
network. 
 
a. Enable HTTP: Enable or disable the feature of Web service. 
b. HTTP Root: The HTTP root path. All the html and gif files will be located here. 
c. Port Number: The default port number is 80 but if there is already one WEB server 
running you can change SentryPlus Service HTTP port number to a different number.  At 
the Internet Browser you can input http://172.16.176.141:2000 in the URL where 2000 is 
the assigned port number. 
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Control 
 
 
 
 
 
 
 
 
 
 
 
Shutdown Now 

This command will execute the shutdown procedure at once. 
a. Restart: This function lets you restart the UPS automatically after being shutdown.  To 
start the UPS for the next schedule, mark the Restart check box. 
b. Shutdown OS and UPS: Use this function to shutdown both the OS and UPS. 
c. SHUTDOWN OS Only: Use this function to shutdown OS only. 
d. SUSPEND OS Only: Use this function to suspend your operating system. 
e. HIBERNATE OS Only: Use this function to hibernate your operating system. 
 
 
 
 
 
 
 
 
 
 

Cancel Shutdown 
This menu enables you to terminate the current shutdown procedure. 
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Turn Receptacle Relay On (not all UPSs support this function) 
Turns the selected receptacle relay on.  Each Receptacle Relay may control more than 
one outlet, please see the rear panel of your UPS or the UPS User's Manual. 
a. Select a Receptacle Relay: Selects a receptacle relay. 
b. Delay: Set the delay time to turn on the outlet group. 
c. On: Executes the turn on command. 
 
 
 
 
 
 
 
 
 
 

Turn Receptacle Relay Off (not all UPSs support this function) 
Turns the receptacle relay off.  Each Receptacle Relay may control more than one outlet, 
please see the rear panel of your UPS or the UPS User's Manual. 
a. Select a Receptacle Relay: Selects a receptacle relay. 
b. Delay: Set the delay time to turn off the outlet group. 
c. Off: Executes the turn off command. 

 
 
 
 
 
 
 
 
 
 
UPS Audible Alarm On 

Enables the UPS’ audible alarm.  On the Bottom Layer Buttons press the Status button to 
get the UPS’ alarm status. 
 

UPS Audible Alarm Off 
Mutes UPS’ audible alarm. 



 37

10-Second Test 
UPS switches to backup mode and the output power is supplied by the battery for 
10-seconds. 
 

Deep Battery Test 
UPS switches to backup mode and the battery supplies the output power until the Low 
Battery Warning (LBW). 
 

Cancel Test 
Cancels the test immediately. 
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View 
 
 
 
 
 
 
 
 
 
 
Meters 

SentryPlus supports up to 12-meters that display real-time values.  Each meter has the 
ability to display all of the UPS values.  Selecting different items from the Selection dialog 
box will display the selected item value. 
a. 2, 4, 6, 8, 12: Displays the number of meters. 
b. Selection: Assigns each meter to a different UPS item value. 
c. Close: Closes the meter window. 
 
 
 
 
 
 
 
 

Event Log 
This menu offers you the possibility of viewing past events. 
a. Print: Prints the event log. 
b. Exit: Closes event log dialog box. 
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History Graph 
Clicking on the History Graph opens a dialog box that contains information about the UPS 
data in graphic format.  This information is available only if there is an accumulation of 
data.  You can select the month and year you want to view.  
a. Horizontal Scale: Selects the time scale. 
b. Vertical Scale: Selects the value scale. 
c. Select Month: Displays the UPS data for the month, which you want to see. 
d. Draw Item1 (Blue): Displays the UPS item value by a blue line. 
e. Draw Item2 (Red): Displays the UPS item value by a red line. 
f. Update: Updates the graph. 
g. Print: Exports the graph to a printer. 
h. Exit: Closes the history graph dialog box. 
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History Data 
Clicking on the History Data opens a dialog box that contains information about the UPS 
data.  This information is available only if there is an accumulation of data.  You can 
select the month and year you want to view. 
a. Select Month: Displays the UPS data in the month, which you want to see. 
c. Save As: Saves the data to the file that you assigned. 
d. Print: Exports the data to a printer. 
e. Exit: Closes the history data dialog box. 

 
 
 
 
 
 
 
 
 
 
 
Remote Hosts 

Detects the hosts, which are running the SentryPlus Service in the LAN. You can also type 
in the IP address and connect to the WAN. 
a. Search Result: The hosts will be listed in the Search Result list box.  Select the host 
you want to connect to and press the Connect button to establish the connection. 
b. Connect to this IP address: SentryPlus will connect to the IP address, which you type in. 
c. Connect: Establish the network connection. 
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Wizard 
 
 
 
 
 
 
 
 
 
Language 

Language: Choose a language that suits your operating system needs.  The software will 
automatically replace the on-line help file and audio files to your selected preferences. 
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Master/Slave 
Please refer to the SentryPlus Service operation mode.  If the computer connects to UPS 
directly (with RS-232 or USB) and can send commands to its connected UPS then the 
SentryPlus Service acts as a "Master".  If it connects to UPS directly (with RS-232 or USB) 
but only listens to UPS then it is a "Serial Slave".  If the computer is powered by the UPS, 
but obtains the UPS information from Master via TCP/IP network then it is a "Networking 
Slave".  When SentryPlus Service is a Networking Slave you must assign the Master IP 
address so that the Networking Slave can connect to the Master and obtain the UPS 
information. 
a. Master: Configures the SentryPlus Service to be a Master. 
b. Serial Slave: Configures the SentryPlus Service to be a Serial Slave. 
c. Networking Slave: Configures the SentryPlus Service to be a Networking Slave. 
d. Master IP Address: When SentryPlus Service is a Networking Slave you must assign 
the Master IP address so that the Slave can connect to the Master host and obtain the 
UPS information. 
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Shutdown 
Shutdown/Suspend the operating system or shutdown the UPS.  If you select the 
shutdown item SentryPlus will execute or ignore the Auto-Save function depending on your 
selection in the Action dialog box.  But if you select the “suspend” or “hibernate” item, the 
program will ignore the Auto-Save function.  The action of “shutdown”, or “suspend” are 
the same as if you select the Shutdown option from the Windows Start menu. 
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Bottom Layer Buttons 
 
Each button shows the respective information in the Information Area. 
a. Main: General Information about the UPS.  
b. Tree: There are 2 sub-trees in the SentryPlus tree:  System and UPS.  The system tree is 
for host information and the status of Master/Slave connection, the UPS tree is for all other UPS 
information. 
c. Time: Displays the time for all schedules, battery replacement date and countdown time. 
d. Status: UPS status. 
e. Diagram: Displays the input and the output power flow of the UPS. 
f. Scroll: UPS data graph. 
g. Receptacle: Displays the UPS receptacle status (If your UPS cannot control the receptacle 
this button will not appear). 
h. Network: Indicates the connection of Master/Slave, SentryPlus Monitor and SentryPlus 
Service. 
 
 
 
 
Main 

a. UPS Health: 3-levels: Green, yellow and red. 
b. UPS Type: On-Line, Off-Line, Line-Interactive or 3-phase On-Line. 
c. UPS Model: The UPS model, which is being monitored by SentryPlus. 
d. Firmware Version: Indicating the firmware version of the UPS. 
e. Host Name: The host, which runs SentryPlus. 
f. Rating VA: The UPS VA rating. 
g. Rating Input Voltage: The UPS input voltage rating. 
h. Rating Current: The UPS current rating. 
i. Rating Battery Voltage: The UPS battery voltage rating. 
j. Rating Input Frequency: The UPS input frequency rating. 
k. Test Result: Results of the last self-test. 
l. AC Source: Normal, battery or bypass. 
m. Battery Status: The status of battery. 
n. Battery Level: Percentage of battery level. 
o. Loading: Percentage Output loading. 
p. SentryPlus with the ability to change the display item of the meters, the referred menu 
item: System-> Main Screen. 
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UPS Tree 
System: System tree for host information and the connection of Master/Slave. 
UPS: UPS tree for all of the UPS information. 
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Time 
a. Last Battery Replacement Date: To change the date of last battery replacement in the 
System-> Configuration UPS->UPS Property. 
b. Next Battery Replacement Date: To change the date of next battery replacement in the 
System-> Configuration UPS->UPS Property. 
c. Next 10 seconds Test Time: System-> Configuration UPS-> Schedule. 
d. Next Deep Test Time: System-> Configuration UPS-> Schedule. 
e. Next Shutdown UPS Time: system->Configuration UPS-> Schedule. 
f. Next Restart UPS Time: System-> Configuration UPS-> Schedule. 
g. Battery Runtime to empty (Estimated):  This is the estimated time the UPS will run in 
the Battery Mode. 
h. Close Operating System Countdown: This is the amount of time before shutting down 
the OS. 
 
 
 
 
 
 
 
 
 
 
 
 

Status 
Shows all of the UPS status, red light indicates this event happened. 
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Diagram 
Input and output power flow of the UPS. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Scroll 
Records the most recent UPS data information.  You can change the displayed item from 
System->Main Screen. 
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Receptacle 
Displays the UPS receptacle status (If the UPS does not support this feature the 
receptacle button will not appear). 
a. Status: Identifies the current outlet status: Normal or Shut. 
b. Next Turn Off Time: System->Configuration->UPS->Schedule. 
c. Next Turn On time: System->Configuration->UPS->Schedule. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Network 
Displays all the SentryPlus Services searched in the LAN. 
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Obtaining Technical Assistance 
 
For Technical Support on the Web, please visit the Support section of our Web site or visit our online Discussion 
Forum at www.minutemanups.com.  Please have the information listed below ready when you contact us.  You 
can reach us by calling:  Phone:  1-972-446-7363, Fax:  1-972-446-9011. 

In order to diagnose the problem you are having, our technicians need the following information from you. 

Installation Site: 
Company Name:             

Address:              

City:       State:   ZIP code:    

Contact Person’s Name:            

Phone Number:              

If you are a consultant, 
Consultant Name:             

Phone Number:       Fax Number:      

Computer System: 
Operating System and version:            

System Manufacturer:             

System Model Number:             

NMS name and revision number:           

               

UPS: 
Model Name/Number:             

Serial Number:              
What are the symptoms? 
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